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IM500008 

Inventor to Revit: Revit Project Export from Inventor for BIM Collaboration 

Paul Munford, Autodesk 

Description 

In this class, we’ll explore the new Export Revit Project (RVT file) functionality in Inventor 2022 

software. 

We'll explore why BIM (Building Information Modeling) is important to building product 

manufacturers, custom fabricators, and industrial facility owners, and level set on Inventor 

software's existing BIM interoperability tools. 

We'll then work our way through a five-part workflow example that includes, 

• Importing Revit data with AnyCAD for Inventor for Revit projects (RVT file) 

• Simplifying the manufacturing design model in Inventor, “bottom up” (with simplify) and 

“top down” using Model States (also new in Inventor 2022) 

• Exporting the Inventor model as a Revit project (RVT file) 

• Linking the Inventor model into Revit for review and collaboration 

• Updating the Inventor model and updating the export to see the design update in Revit. 

We'll provide a data set, and written, and video recorded instructions, and there’ll be a live Q&A 

session on Tuesday 5 October 2021 10:00 AM Pacific time. 

Supporting documents 

Don’t forget to download the dataset and watch the video of the presentation from AU Online. 

https://www.autodesk.com/autodesk-university/class/Inventor-Revit-Revit-project-export-

Inventor-BIM-collaboration-2021 

  

Learning Objectives 

• Learn how to simplify your Inventor model, in preparation for exporting to Revit 

• Learn how to export your Inventor model as a native Revit file 

• Learn how to link your Inventor file into Revit 

• Learn how to update the Inventor model, and also update the Revit export 

https://www.autodesk.com/autodesk-university/class/Inventor-Revit-Revit-project-export-Inventor-BIM-collaboration-2021
https://www.autodesk.com/autodesk-university/class/Inventor-Revit-Revit-project-export-Inventor-BIM-collaboration-2021
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Paul Munford 

Paul Munford is a laugher, dreamer, raconteur, CAD geek, and 

Technical Marketing Manager for Autodesk in the UK. 

Paul 's background in manufacturing items for the construction 

industry gives him a foot in digital prototyping and a foot in Building 

Information Modeling (BIM). 

Paul was a speaker at Autodesk University for the first time in 2012, 

and he says it's the most fun anyone can have with 250 other people 

in the room. 

@PaulCADmunford 

 

What is BIM? 

‘BIM’ or Building Information Modelling’, is the process of collaborating on a digital, 3D database 

of information about a building design. 

A ‘BIM’ is the Building Information Model itself. 

A BIM is created using a BIM authoring tool such as Autodesk Revit and is compiled from 

several separate 3D model/databases each created by a different specialist - for example, an 

Architectural BIM, a Structural BIM, and a Mechanical BIM. 

At each design stage, the BIMs can be coordinated, so that the overall design has no 

contradictions before being released to the wider project team. 

The coordinated BIM is a 3D model that represents a database of information about the design. 

Schedules, drawings, and even simulations or renderings are all ‘views’ of the same database. 

The design BIM can be passed on to the General Contractor, who can continue to update the 

BIM by incorporating 3D models from trade subcontractors and specialists. 

Eventually, the ‘As Built’ BIM can be passed on to the building owner, who can use the BIM 

database for asset management throughout the buildings lifecycle.  

BIM for Manufacturing Facility Owners 

In this class, we will take the part of a manufacturing facility team. We need to coordinate our 

production line equipment installation with the factory building and its services (Mechanical, 

Electrical, and Plumbing). 

We have been supplied with a Revit BIM to help us work in context with the Architects design. 

Our deliverable will be a 3D model that can be returned to the General contractor and Architect 

for design coordination and approval.  

https://twitter.com/PaulCADMunford


 

3 | P a g e  

 

Table of Contents 

Learning Objectives ................................................................................................................. 1 

Description ............................................................................................................................... 1 

Supporting documents ............................................................................................................. 1 

Paul Munford ........................................................................................................................... 2 

What is BIM? ........................................................................................................................... 2 

BIM for Manufacturing Facility Owners .................................................................................... 2 

About this class ........................................................................................................................ 4 

Your feedback.......................................................................................................................... 4 

Your questions ......................................................................................................................... 4 

Prerequisites ............................................................................................................................ 5 

Installing Inventor and Revit 2022 ........................................................................................ 5 

Downloading a trial of Inventor 2022 .................................................................................... 5 

Downloading a trial of Revit 2022 ......................................................................................... 6 

A note on versioning ............................................................................................................. 7 

The Video ................................................................................................................................ 7 

The Handout ............................................................................................................................ 7 

The Dataset ............................................................................................................................. 8 

The Demos .............................................................................................................................. 8 

Conventions ............................................................................................................................. 8 

Setup – Before we begin… ................................................................................................... 9 

Exercises ............................................................................................................................... 11 

Exercise 00 - In Revit, creating a simplified View................................................................ 11 

Exercise 01 - In Inventor, reference a Revit model into Inventor using ‘AnyCAD’. .............. 23 

Exercise 02 - Insert an Inventor model, and constraint it to the Revit model. ...................... 30 

Exercise 03 - Export to RVT ............................................................................................... 48 

Exercise 04 – Link the RVT export into a Revit model ........................................................ 51 

Exercise 05 – Update the Inventor model, Exported RVT, and Linked model in Revit ........ 54 

Conclusion ............................................................................................................................. 56 

What next? ............................................................................................................................ 56 

Thanks ............................................................................................................................... 57 

Resources ............................................................................................................................. 58 

file:///C:/Dropbox/AU%202021/05%20Handout/ClassHandout-IM500008-Munford-AU2021.docx%23_Toc83717815


 

4 | P a g e  

 

Your feedback for Autodesk ................................................................................................... 58 

 

About this class 

At Autodesk University, a ‘Lab’ style class is an opportunity to get hands on with Autodesk 

software. The Lab instructor takes you through the exercises and there are ‘Lab Assistants’ to 

help you if you get stuck. 

Due to the coronavirus pandemic, AU is entirely virtual this year. This means that you’ll have to 

work a little harder to get the best out of this class. You’ll need to install the software yourself, 

download the handout and dataset, and follow the instructions with little help from me, and no 

Lab assistants. 

I’ve tried to make the instructions for each exercise as straight forward and as easy to follow as 

possible. I welcome your feedback on how I can improve this for you. 

Please watch the video of the presentation that goes with this class. I will demonstrate key steps 

for you. You can then use the step-by-step instructions in this handout to try the workflow out for 

yourself. 

I have supplied a dataset with files for each exercise. If you don’t get the result you were 

expecting during an exercise, don’t worry – just close the file you are working on and then open 

the file from the folder for the next exercise.  

You don’t need to do the exercises sequentially. Each exercise stands by itself, so you can pick 

the exercises which will help you build the skills that are relevant to you. 

Your feedback 

If you have any feedback on this class, the format, the dataset, the handout, or the presentation, 

please feel free to contact me: Paul.Munford@Autodesk.com 

To show your appreciation, please use the 

‘Recommend’ button on the Autodesk university 

online webpage for this class. 

Your questions 

You can ask questions via the ‘Comments’ box 

on the Autodesk University Online web page for 

this class.  

During the week of AU2021 (w/c 5th October 

2021) I will monitor your questions and answer as 

many as I can. 

You will also be able to join us for a LIVE Q&A 

session Tuesday 5 October 2021 10:00 AM 

mailto:Paul.Munford@Autodesk.com
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Pacific time (This session will be recorded and included on the AU online class page). 

Prerequisites 

To follow the instructions in the class, you will need: 

• The Handout 

• The Dataset 

• Autodesk Inventor 2022 Installed on your computer 

(Including the Revit Interoperability 2022.0.1 Hotfix for Inventor 2022) 

• Autodesk Revit 2022 Installed on the same computer. 

It is expected that you will be familiar with basic concepts in Inventor and Revit, such as opening 

files, navigating within the file structure, and navigating in 3D space. 

 

Installing Inventor and Revit 2022 

If your subscription includes Autodesk Inventor 

and/or Revit 2022, you can install them via the 

Autodesk Desktop app, or via your Autodesk 

account. 

You can also install the Revit Interoperability 

2022.0.1 Hotfix for Inventor 2022 from the 

desktop app. 

Tip: Look for it under ‘Revit updates’ or find it 

using the search function. You’ll find more 

information on the hotfix here: 

Click here to find out more about the Revit 

Interoperability 2022.0.1 Hotfix for Inventor 2022 

 

You can also download software from your Autodesk account, log in using your Autodesk ID and 

password here: 

https://manage.autodesk.com/home/ 

Downloading a trial of Inventor 2022 

You can download a free 30-day trial of Autodesk Inventor using this link: 

https://www.autodesk.co.uk/products/inventor/free-trial 

Figure 1The Autodesk Desktop App 

https://knowledge.autodesk.com/support/inventor/troubleshooting/caas/sfdcarticles/sfdcarticles/When-trying-to-open-an-RVT-file-with-Inventor-2022-an-error-message-0x8013150d-C-Program-Files-Common-Files-Autodesk-Shared-Revit-Interoperability-2022-Rx-ATFRevitRCEHost-exe-is-received.html
https://knowledge.autodesk.com/support/inventor/troubleshooting/caas/sfdcarticles/sfdcarticles/When-trying-to-open-an-RVT-file-with-Inventor-2022-an-error-message-0x8013150d-C-Program-Files-Common-Files-Autodesk-Shared-Revit-Interoperability-2022-Rx-ATFRevitRCEHost-exe-is-received.html
https://manage.autodesk.com/home/
https://www.autodesk.co.uk/products/inventor/free-trial
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If you’ve never used Autodesk Inventor before, please visit the trial center for ‘getting started’ 

tutorials: 

https://www.autodesk.com/campaigns/inventor-

trial-center 

Or look at the in-product Tutorial Gallery 

 

Downloading a trial of Revit 2022 

You can download a free 30 day trial of Autodesk Revit using this link: 

https://www.autodesk.co.uk/products/revit/free-trial 

If you’ve never used Autodesk Revit before, please visit this link for ‘getting started’ tutorials: 

https://knowledge.autodesk.com/support/revit-products/getting-

started/caas/CloudHelp/cloudhelp/2020/ENU/Revit-GetStarted/files/GUID-C3DEF8F6-A9C0-

496E-A554-8147B12A4EDA-htm.html 

Tip: On installation of Revit, you may see this screen. Please follow the prompts. 

 

  

https://www.autodesk.com/campaigns/inventor-trial-center
https://www.autodesk.com/campaigns/inventor-trial-center
https://www.autodesk.co.uk/products/revit/free-trial
https://knowledge.autodesk.com/support/revit-products/getting-started/caas/CloudHelp/cloudhelp/2020/ENU/Revit-GetStarted/files/GUID-C3DEF8F6-A9C0-496E-A554-8147B12A4EDA-htm.html
https://knowledge.autodesk.com/support/revit-products/getting-started/caas/CloudHelp/cloudhelp/2020/ENU/Revit-GetStarted/files/GUID-C3DEF8F6-A9C0-496E-A554-8147B12A4EDA-htm.html
https://knowledge.autodesk.com/support/revit-products/getting-started/caas/CloudHelp/cloudhelp/2020/ENU/Revit-GetStarted/files/GUID-C3DEF8F6-A9C0-496E-A554-8147B12A4EDA-htm.html
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A note on versioning 

The functionality we are learning about in this class did not exist prior to Inventor 2022. The 

workflow described in this class will not work with older versions of Inventor. 

Inventor 2022 can reference Revit files that are from previous versions of Revit (older than 2022) 

however – you will notice a performance hit. In the background, Inventor is updating the Revit 

file from the previous version to Revit 2022. 

To avoid this performance hit, it is recommended that you update the Revit project to Revit 2022 

in Revit first, before you reference it into Inventor 2022. 

The Video 

The video of the presentation that goes with this class will give context on why the workflow is 

helpful to manufacturers who are coordinating their machine designs with a Building Information 

Model (BIM), along with a recording of the key points for each exercise. 

Please watch each demo in its entirety, before pausing the video and trying the workflow for 

yourself. 

You can use the instructions in the handout to help you follow along with the exercise, or re-wind 

the video and follow along. 

The Handout 

If you are reading this – you have the handout - Thank you! 

The handout will take you through each exercise step-by-step, including the file and folder path 

to the example files you will be using. 

The instructions in the handout follow the demo of the exercise we will see in the video of the 

presentation. 

I have been able to include extra detail and references to further information in the handout that I 

didn’t have time for in the presentation. 
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The Dataset 

The dataset is a zipped file containing all the files you need for the exercises we will be working 

on.  

The files for each exercise are self-contained. If you don’t get the result you were expecting at 

the end of an exercise – don’t worry. Just close the file that you are working on and then open 

the example file from the folder for the next exercise. 

Please download the dataset and extract the zipped files directly on to your C: Drive. 

We recommend saving the class files in this folder location ‘C:\Datasets\IM500008’. 

You can download the dataset from the Autodesk University online page for this class, or you’ll 

also find it here: https://cadso.co/IM500008_DOWNLOAD 

The Demos 

Key points from the exercises are demonstrated in the video of the presentation for this class. 

Please watch each demonstration in full before you start the exercise.  

You can use the instructions in the handout to help you follow along with the exercise, or re-wind 

the video and follow along. 

Conventions 

LMB = Click your left mouse button 

RMB = Click your right mouse button 

Double-click = Left mouse button click twice in quick succession. 

SHIFT+CTRL = Hold down your SHIFT key and your CONTROL key at the same time. 

  

https://cadso.co/IM500008_DOWNLOAD
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Setup – Before we begin… 

Before we begin, please check that you have the following: 

 Inventor 2022 installed 

(Including the Revit Interoperability 2022.0.1 Hotfix for Inventor 2022) 

 Revit 2022 Installed 

 Dataset downloaded and extracted to C:\Datasets\IM500008 

 The Handout  

 The Video of the presentation 

Please start Inventor and set the project file to point at the class dataset. 

With Inventor 2022 open, go to: 

1. Get started (Tab) > Launch (Panel) > Projects (Button) 

2. In the ‘Projects’ dialog, click on ‘Browse…’  

3. In the ‘choose project file dialog’ browse to C:\Datasets\IM500008 

(or wherever you saved and extracted the dataset for this class) 

4. Select the project file ‘IM500008.ipj’ with a left mouse button click and click the 

‘Open’ button. 

5. In the ‘Projects’ dialog, check that ‘IM500008.ipj’ has a ‘check’ mark next to it (✓) 

6. Click on the ‘Done’ Button. 
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Tip: With the IM500008.ipj project file active, the open dialog will contain shortcuts to frequently 
used folders – in this case, the folder for each exercise. 
 
Click on ‘Workspace’ to go to the containing folder for the whole dataset, click on the shortcuts to 
go directly to the class folders. 
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Exercises 

Exercise 00 - In Revit, creating a simplified View. 

When we bring a Revit project file into Inventor, we don’t want to bring in EVERYTHING! The 

referenced Revit model would be large and unwieldy and would slow down Inventor. 

To reduce the size of the referenced Revit model file in Inventor, we can reference in a saved 

view of the Revit model, which has been filtered to just the information we are interested in. 

In real life, Inventor users may ask a colleague who is working on the Revit model to provide a 

specific view. 

In this exercise we will learn how to create a view of the Revit model, which shows only the 

detail we are interested in. 

In this Exercise we will: 

• Open the data set for this exercise 

• Browse the Revit project structure 

• Copy and rename an existing 3D View 

• Filter the view 

• Use a Section box to crop the view 

Open the data set for this exercise 

1. From the Revit home page, look for ‘MODELS’ and click ‘Open’ 

2. Navigate to: 

C:\Datasets\IM500008\00 Creating a simplified View in Revit\ 

3. LMB select ‘AS-AK-00-ZZ-M3-A-00001_Create a View.rvt’ 

(Revit Project File) and click on the ‘Open’ button. 
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Tip: Within the Revit ‘Open 

dialog’, navigate to your 

‘C:\Datasets\IM500008’ 

folder. 

Now right mouse button 

click over the ‘places’ bar 

and choose ‘Add current 

folder’ This will create a 

short cut to the class 

dataset folder in your places 

bar.  
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Tip: If you get stuck, open the completed file for this exercise: 

AS-AK-00-ZZ-M3-A-00001_Create a View_END.rvt 

Browse the Revit project structure 

1. In Revit, look for the ‘Project Browser’. 

2. Next to the ‘Views (all)’ node, click on the cross (+) symbol to expand the node. 

3. Look for the view called ‘3D View: 3D’ 

4. This view should be the current view. 

Tip: You’ll know the view called ‘3D’ is current if the view name is in Bold text. The view name 

will also be shown at the tab of the current graphics window. 

Copy and rename an existing 3D View 

1. Right mouse button click on the ’3D View: 3D’node and select: 

‘Duplicate view > Duplicate’ 

2. A new view will be created called ‘3D View: 3D Copy 1’ and Revit will set it as the 

current view. 

3. Right mouse button click on the ’3D View: 3D Copy 1’ node and select: 

‘Rename’ 

4. Rename ‘3D Copy 1’ to ’Production B’ 

Tip: To change views, double left mouse button click (LMB) on ’3D View: 3D’ node to make it 

current. Double LMB click on ’Production B’ to make it current again for the next step. 
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Filter the view 

Now that we have our own view, we can hide the elements that we don’t want to see inside 

Inventor. In our example, we are going to hide elements such as the trees and cars. 

To hide individual elements in a Revit view, hover your cursor over the element that you’d like to 

hide. If another element highlights, use the tab key to cycle between overlapping elements until 

the element you mean to select is highlighted. 

When you have the element highlighted that you want to remove, Right Mouse Button click 

(RMB) and choose: 

‘Hide in View > Elements’ 

 

Tip: Use ‘Hide in View > Category’, to hide all elements that belong to the same category, such 

as all walls, or all windows. 

Tip: To select all instances of an element, select an element, and then RMB and choose ‘Select 

all instances > Visible in View’ to select all instances of the same element. With the selection 

set active, you can now RMB click and choose ‘Hide in View > Elements’ to hide all instances 

of an element. 

Tip: You can hold down the CTRL key and LMB on multiple elements to select multiple elements 

from different categories. 
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A quicker way to simplify the view, is to select everything, and then use a filter to select only the 

elements we don’t want to see. We can then hide all these elements at once. 

If necessary, use the scroll wheel on your mouse to zoom out until you can see the whole Revit 

model. 

Tip: To Pan, hold down the scroll wheel while moving your mouse. To Orbit, hold down the 

SHIFT key on your keyboard plus hold down the scroll wheel while moving your mouse.  

 

Tip: You may need to choose ‘Unlock 

view’ from the tool tray to navigate a 3D 

view. 

 

 

 

Tip: Model navigation may be better 

behaved if you set the view style to 

‘Orthographic’ using the View Cube 

options. 
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Filter the view (continued) 

 

1. In the graphics window, left mouse button click and drag from the top left of the window 

to the bottom right of the window. You should now have the entire Revit model selected. 

 

2. Navigate to: 

Modify | Multiselect (Tab) > Selection (Panel) > Filter (Button) 

 

Tip: You won’t see the ‘Modify’ tab until you have something selected! 
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3. Click on the Filter button. 

4. In the Filter dialog, notice that all Revit 

categories are represented. 

5. Click the ‘Check None’ button. 

 

 

 

 

 

 

 

 

 

 

 

6. Now select the categories we wish to hide: 

✓ Entourage 

✓ Generic Models 

✓ Parking 

✓ Planting 

✓ Site 

 

 

7. Click the ‘OK’ Button. 
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8. Only the items that belong to the categories we selected are highlighted. 

 

9. Right mouse button anywhere in the graphics window and choose: 

‘Hide in View > Elements’ 

 

10. The elements we don’t wish to see in Inventor are hidden.  

Only the items we are interested in are visible. 
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Use a Section box to crop the view 

We can also focus on the detail we are interested in by using a Section box. A Section box will 

crop the Revit model to just the area we are interested in. 

Tip: Before you start the next section, make sure that you don’t have anything selected by 

pressing the ‘Escape(esc)’ key a couple of times. 

 

1. In the Properties browser, under ‘Extents’, check ‘Section box’. 

2. A wireframe box will appear around the extents of the Revit model. 

3. Left mouse button click on the section box to activate it – Triangular handles will appear 

at the center of each face. 

4. Use the triangular handles to crop the view of the model to show just the area around the 

Production B area on the first floor 

(Don’t worry about doing this accurately, just get the feel of the tool) 
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5. Save your version of this file using: 

File > Save as > Project 

And then close this Revit file. 

Or go to: 

File > Close 

To close the file without saving and use the file I’ve prepared for you for the next 

exercise. 

 

 

Tip: To make cropping easier, use the 

view cube to orient the view until you 

are parallel with the sides of the 

section box. 

To switch to orthographic view, hover 

over the Viewcube and look for the 

options button (It looks like a 

rectangular bar, with a triangle 

underneath it). 

From the options select 

‘Orthographic’. When you are done, 

you can switch back to perspective 

mode the same way. 

 

 

 

 

 

 

Tip: Revit comes with three standard view resolutions – called ‘Detail Levels’. The three detail 

levels are ‘Fine’, ‘Medium’ and ‘Coarse’. You can change detail level using the control in the tool 

bar. 
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Figure 2 Detail Level = FINE 

 

Figure 3 Detail Level = MEDIUM 

 

Figure 4 Detail Level = COARSE 
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Extra credit 

To hide the section box, select it with a LMB click, then RMB click and chose: 

‘Hide in View > Elements’ 

To show the section box again, LMB click on the ‘Reveal hidden elements’ button from the Tool 

tray (It looks like a light bulb. It will turn Red when you click on it). 

 

Hover over the section box until it highlights, then RMB click and choose: 

‘Unhide in View > Elements’. 

 

Then, LMB click on the ‘Reveal hidden elements button in the tool tray again. 

• How would you hide the section box again? 

• How would you change from orthographic to Perspective view? 

• How would you save the orientation and lock the view?  
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Exercise 01 - In Inventor, reference a Revit model into Inventor using ‘AnyCAD’. 

Before the release of Inventor 2021, we could only ‘Import’ a Revit project (.RVT) file into 

Inventor. 

This meant the file was converted from a Revit file to an Inventor file. The link to the original 

Revit file was lost. If the Revit file was updated, we would have to be import it into Inventor 

again. 

This meant that we had to re-create any references (projected sketches and relationships) that 

we had made between the Revit model and the Inventor model – this could be a lot of work! 

Additionally, we had no way of knowing what was in the Revit file until we had imported it. We 

would then have to do manual clean up to delete any elements that we didn’t need. When we 

received an updated version of the Revit file – we would have to do this again! More work! 

Inventor AnyCAD for Revit file solves both these problems. We can reference a Revit project file 

into Inventor, taking advantage of any views that were pre-defined in Revit to filter the imported 

geometry. 

We can even filter the Revit import by category, to further eliminate unwanted geometry. 

The link back to the original file remains ‘live’. If the Revit file is updated and saved, we will see 

the update in Inventor. Any relationships we have made will also update (within reason!). 

Let’s see how it’s done. 

In this Exercise we will: 

• Open the data set for this exercise 

• Insert a 3D view of a Revit project file into our Inventor assembly 

• Browse the Revit project structure, and change the visibility state of an element 

• Insert an Inventor model. 

Open the data set for this exercise 

Before starting this exercise, please make sure that you’ve closed any files that you previously 

had open in Revit. 

1. From the Inventor home page, navigate to: 

Get started (Tab) > Launch (Panel) > Open (Button) 

2. Navigate to: 

3. C:\Datasets\IM500008\01 AnyCAD Revit to Inventor\ 

4. LMB select ‘AnyCAD_Into_Inventor.iam 

(An empty Inventor assembly file) and click on the ‘Open’ button. 

Tip: Open ‘AnyCAD_Into_Inventor_END.iam’ to see a completed version of this exercise. 
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Inserting a 3D view of a Revit project file into an Inventor assembly 

We will use ‘AnyCAD’ to reference a Revit project into our empty Inventor assembly. 

1. Navigate to: 

Assemble (Tab) > Component (Panel) > Place (Button) 

Note: The ‘Place’ button always shows the last option 

used. It may read ‘Place from Content Center’ or ‘Place 

iLogic Component’ (for example). 

Click on the bottom half of the ‘Place’ button to see the 

complete list of place options. 

2. Choose ‘Place Imported CAD File’. 

3. Browse to: 

C:\Datasets\IM500008\02 AnyCAD Revit to 

Inventor\ 

4. LMB select ‘AS-AK-00-ZZ-M3-A-

00001_AnyCAD_Into_Inventor.rvt’ 

(Revit Project file) and click on the ‘Open’ button. 

5. In the ‘Import’ dialog, select ‘Production B’ from 

the drop-down menu. 

6. Make sure that ‘Reference model’ is selected. 

Click ‘OK’ 

(If you see the performance warning – just click 

OK). 

When the importing process is complete, you will see 

a preview of the Revit project ‘Float’ into your 

assembly, following your mouse cursor. 

7. Right mouse button click, and choose ‘Place 

Grounded at Origin’ 

(you may need to use your scroll wheel on your 

mouse to zoom out a little bit). 

8. Right mouse button click again and choose 

‘Cancel (esc)’ to finish placing instances. 

9. You can keep the file open for the next section. 

Tip: You can also choose to filter by category on import. Categories with a ‘check’ mark (tick) will 

be included. Categories without a tick will be excluded. 
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Tip: if you receive an error on inserting the Revit file, please install Revit Interoperability 

2022.0.1 Hotfix for Inventor 2022, from the Autodesk desktop app, or your Autodesk account portal. 

You’ll find it under ‘Revit’ – don’t look for it under Inventor (like I did!) 

 

 

 

 

 

 

 

https://knowledge.autodesk.com/support/inventor/troubleshooting/caas/sfdcarticles/sfdcarticles/

When-trying-to-open-an-RVT-file-with-Inventor-2022-an-error-message-0x8013150d-C-

Program-Files-Common-Files-Autodesk-Shared-Revit-Interoperability-2022-Rx-

ATFRevitRCEHost-exe-is-received.html 

 

Tip: Don’t worry about the performance warning – you can click OK. This warning is very 

conservative, I haven’t had any problems bringing Revit models into Inventor (so far!). 

 

 

 

 

 

 

 

https://knowledge.autodesk.com/support/inventor/troubleshooting/caas/sfdcarticles/sfdcarticles/When-trying-to-open-an-RVT-file-with-Inventor-2022-an-error-message-0x8013150d-C-Program-Files-Common-Files-Autodesk-Shared-Revit-Interoperability-2022-Rx-ATFRevitRCEHost-exe-is-received.html
https://knowledge.autodesk.com/support/inventor/troubleshooting/caas/sfdcarticles/sfdcarticles/When-trying-to-open-an-RVT-file-with-Inventor-2022-an-error-message-0x8013150d-C-Program-Files-Common-Files-Autodesk-Shared-Revit-Interoperability-2022-Rx-ATFRevitRCEHost-exe-is-received.html
https://knowledge.autodesk.com/support/inventor/troubleshooting/caas/sfdcarticles/sfdcarticles/When-trying-to-open-an-RVT-file-with-Inventor-2022-an-error-message-0x8013150d-C-Program-Files-Common-Files-Autodesk-Shared-Revit-Interoperability-2022-Rx-ATFRevitRCEHost-exe-is-received.html
https://knowledge.autodesk.com/support/inventor/troubleshooting/caas/sfdcarticles/sfdcarticles/When-trying-to-open-an-RVT-file-with-Inventor-2022-an-error-message-0x8013150d-C-Program-Files-Common-Files-Autodesk-Shared-Revit-Interoperability-2022-Rx-ATFRevitRCEHost-exe-is-received.html
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Tip: ‘Place Grounded at Origin’ Places the Revit project into the Inventor assembly with the 0,0,0 

coordinate of the Revit file mapped to the 0,0,0 coordinate of the Inventor file. 

This means that we can work in the context of the building design, and when we export the 

Inventor model – it will map back to the correct location in Revit. 
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Browse the Revit model structure, and change the visibility state of an element 

First, we will create a new View in Inventor which allows us to save the visibility state of 

components in our model.  

Then, we will learn how to locate, select, and hide elements of the Revit model. 

Tip: Zoom in and out, using the scroll wheel on your mouse. Pan the view by holding down the 

scroll wheel while you move your mouse. Orbit the view by holding down the SHIFT key on your 

keyboard and holding down the scroll wheel while moving your mouse at the same time. 

Pause the cursor over a component and pause for two seconds to see a drop-down menu which 

will allows you to select components which are on top of one another.  

 

Use the ‘Component priority’ tool from the quick access tollbar (QAT) to switch between ‘Select 

component priority’ (Top level sub-assemblies or parts) and ‘Select part priority’ (select parts 

only). 

Use the Viewcube menu to change between orthographic and perspective mode. 
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Tip: Open ‘AS-AK-00-ZZ-M3-A-00001_AnyCAD_Into_Inventor_END.iam’to see a completed 

version of this exercise. 

1. In the Inventor model browser, expand the ‘Representations’ node. 

2. Right mouse button click over the node called ‘View:Default’, 

and select ‘New’ 

A new view called ‘View1’ will be created. Left mouse button 

click once on this view to select it, and LMB once again to 

rename it. 

3. Name it ‘Production B. 

4. In the Inventor model browser, click the ‘+’ symbol next to the 

node that represents the Revit model. 

 

Note: Each Revit category is represented by a folder. You 

can browse the folder structure to look for elements. 

5. Hold down the SHIFT key and Right mouse button click at the same time. This short cut 

will bring up the selection filter at your cursor. 

 

Note: you will also find the selection filter in the Quick Access 

Toolbar (QAT). 

 

6. Change the selection to ‘Select Part Priority’ 

7. In the graphics window, select one of the strip lights. 

8. Right mouse button click and choose ‘Find in browser’. 

In the Inventor model browser, you will be taken to the Lighting 

Fixtures element node in the Revit category folder. 

9. With the lighting fixture element selected, right mouse button click and select ‘Visibility’ 

to hide this element. 

 

Note: If you see the ‘Associative Design View Representation’ dialogue, select the OK 

button. 
 

10. To change the visibility of an entire category, select the category folder, right mouse 

button click, and choose ‘visibility’ from the context menu. 
 

You can keep this file open - or close the file if you want to use the version, I’ve prepared for you 

for the next step. 



 

29 | P a g e  
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Exercise 02 - Insert an Inventor model, and coordinate it with the Revit model. 

Now we have a Revit model In Inventor, let’s see how we could design in the context of the Revit 

model. 

In this Exercise, we will: 

• Open the data set for this exercise 

• Insert an Inventor assembly. 

• Look for a coordination issue between the building model and the production Line model. 

Open the data set for this exercise 

If you still have the file open from the previous exercise – continue on. 

If you like, you can open this version of the Inventor assembly that already has the Revit model 

inserted for you. 

1. From the Inventor home page, navigate to: 

Get started (Tab) > Launch (panel) > Open (Button) 

2. Navigate to: 

3. C:\Datasets\IM500008\ 02 Insert and Simplify\ 

4. LMB select ‘Insert_and_simplify.iam (Inventor assembly file) and then click on the 

‘Open’ button. 
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Insert an Inventor assembly. 

We will now insert an Inventor model which represents the equipment in our production line. 

1. Navigate to: 

Assemble (Tab) > Component (Panel) > Place 

(Button) 

Note The ‘Place’ button always shows the last option 

used. It may read ‘Place from Content Center’ or ‘Place 

iLogic Component’ for example. 

Click on the bottom half of the ‘Place’ button to see 

more options 

2. Choose ‘Place’. 

3. Browse to: 

C:\Datasets\IM500008\ 02 Insert and Simplify\ 

4. LMB select ‘Production B.iam’ 

(Inventor Assembly file) 

5. Click on the ‘Open’ button 

(If you see a ‘Factory Environment’ 

warning, don’t worry – you can click ‘OK’, 

or click ‘Prompts >>’ to turn off this 

warning. 

6. Right mouse button click, and choose ‘Place Grounded at Origin’ 

7. Right mouse button click again and choose ‘Cancel (esc)’ to finish placing instances. 

Can you see interference between the Revit and Inventor models? 

If you are using the pre-prepared dataset, you can see the problem clearly, by navigating to 

a view that I’ve saved for you. 

8. In the model browser, expand the ‘Representations’ node. Expand the ‘Views’ node. 

Find the view called ‘Clash’. Hover your cursor over ‘Clash’ then right mouse button 

click and choose ‘Activate’. 

9. Save the file if you wish to keep using it or close the file if you want to use the version 
I’ve prepared for you for the next step. 
 

In this exercise, we grounded the Production B assembly at 0,0,0 – the same coordinates as the 

Revit assembly. 

Alternatively, we could use Joints or constraints to place the Inventor assembly. This would allow 

the Revit model to drive the position, the size, or even the quantity of the Inventor model. 

Tip: For more on this workflow – check out this class on Autodesk University online: 

https://www.autodesk.com/autodesk-university/class/Revit-Inventor-BIM-Exchange-Custom-

Fabrication-Hands-Lab-2020 

https://www.autodesk.com/autodesk-university/class/Revit-Inventor-BIM-Exchange-Custom-Fabrication-Hands-Lab-2020
https://www.autodesk.com/autodesk-university/class/Revit-Inventor-BIM-Exchange-Custom-Fabrication-Hands-Lab-2020
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In the next exercise, we will learn how to simplify the Inventor model and export it as a Revit 

project (RVT) file. 

 

Figure 5 Placing an Inventor assembly. Steps 1 to 5 

 

Figure 6 Step 6 – insert the Inventor assembly at the origin 
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Figure 7 step 7 - Cancel placing Instances 

 
Figure 8 Step 9 Activate the view called 'Clash' to spot the interference between the Inventor and Revit models. 
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Simplify the Inventor model (Top Down) 

The building design team does not want a fully detailed Inventor model – any more than we 

wanted the whole building model! 

Our Inventor model contains all the information we need to procure, manufacture, assemble 

install and commission our design. 

We only need to export the elements of our Inventor model that are required for coordination 

with the building model. The rest of the detail can be removed or simplified. 

Inventor 2022 gives us a newly laid out simplification panel – with a few new tricks that we didn’t 

have in previous releases. 

We also have the option to simplify from the ‘bottom up’ with Model States (More on Model 

states later). 

In this Exercise we will: 

• Continue working with the dataset we have open 

• Create a new view and make elements that aren’t needed in Revit ‘Invisible’. 

Open the data set for this exercise 

If you still have the file open from the previous exercise – continue on. 

If you like, you can open this version of the Inventor assembly that already has the Revit model 

inserted for you. 

1. From the Inventor home page, navigate to: 

Get started (Tab) > Launch (panel) > Open (Button) 

2. Navigate to: 

3. C:\Datasets\IM500008\ 02 Insert and Simplify\ 

4. LMB select ‘Insert_and_simplify_END.iam’ 

(Inventor assembly file) and click on the ‘Open’ button. 
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Let’s look at the model. 

 

5. Change the current view.  

In the model browser, expand ‘Representations’, expand ‘Views’, find ‘Default’. 

6. Hover your cursor over the ‘Default’ view node. Right mouse button and chose ‘Activate’.  

 

Notice that there are elements in this view that we don’t want to export to Revit. For example – 

people, the forklift truck, and the AnyCAD referenced Revit model itself! 

7.  Create a new view – and make unrequired elements invisible. 

8.  In the model browser, expand ‘Representations’ and ‘Views’. 

9. Hover your cursor over the ‘Production B’ node. 

10. Right mouse button click and choose ‘Copy’. 

11. Rename this view ‘Revit Export’. Right mouse button click on ‘Revit Export’ and chose 

‘Activate’ 

Tip: To rename the view, select the text (the name of the view) once with a left mouse button 

click, then pause, then left mouse button click again to make the text editable. 
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12.  Select elements and make them invisible. 

13. In the model browser select the node that represents the Revit model with a left mouse 

button click. 

‘AS-AK-00-ZZ-M3-A-00001_AnyCAD_Into_Inventor - Production B:1’ 

14.  Right mouse button click on this node and choose ‘Visibility’. The Revit model will 

become Invisible. 

15. In the browser, expand the node the represents the Inventor model ‘Production B:1’ 

16. Hover your cursor over the folder named ‘Human’. Right mouse button click and choose 

‘Visibility’ 

Tip: If you see the warning ‘Remove associativity’, don’t worry – you can click ‘OK’ 

 

17. Repeat this process for the folder named ‘Vehicles’. 

You can also select components in the graphics window to change their visibility. Don’t forget to 

use your selection filters to select Assemblies or Parts. Hold down SHIFT+RMB (Right mouse 

button) and the selection filters will appear at your cursor. 

We have been able to eliminate elements that we know aren’t needed for coordination with the 

building design teams Revit Model, and save the selection set as a View representation for re-

use. 

Now, let’s simplify the remaining model further.  
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Simplify (Top down) 

Now we’ve reduced the model to just the elements that we want to export to Revit, let’s see how 

we can simplify our model further.  

We will do this with the ‘Simplify’ tool. This is a ‘Top down’ method. We make a series of 

choices that the simplify tool will use to simplify our model automatically. 

The advantage of this method is that we can save our settings and apply them to any model 

consistently. We can create a company or project standard or work to existing industry standard 

– and everyone on the team can apply the same standard in the same way. 

The disadvantage is that simplification only happens in the context of the assembly. We can’t 

take individual components and use them in their simplified form elsewhere. 

For this we would need a ‘Bottom up’ method of simplification. More on that in the next section. 

In this Exercise we will: 

• Continue working with the dataset we have open 

• Simplify the model using the ‘Simplify’ tool set, prior to exporting to Revit. 

Open the data set for this exercise 

If you still have the file open from the previous exercise – continue on. 

If you like, you can open this version of the Inventor assembly that already has the Revit model 

inserted for you. 

1. From the Inventor home page, navigate to: 

Get started (Tab) > Launch (panel) > Open (Button) 

2. Navigate to: 

3. C:\Datasets\IM500008\ 02 Insert and Simplify\ 

4. LMB select ‘Insert_and_simplify_END.iam’ 

(Inventor assembly file) and click on the ‘Open’ button. 

5. Start the ‘Simplify’ command. 

Assemble (Tab) > Simplification (Panel) > Simplify (Button). 

 

 

Tip: The simplify panel can be docked to the edges of the graphic window, or as a tab with the 

model browser. If you don’t want it to dock, hold down the ‘Control’ (CTRL) key as you drag. 
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6.   Start by looking at the ‘Output’ section, ‘Type’ dropdown, at the bottom of the panel. 

We will choose ‘Revit Model’ from the drop down. 

 

‘New Part file’ will create a derived part containing a 

reference to this assembly. When the assembly is 

updated, the part will update as well. 

 

‘Substitute’ will insert the derived part into the current 

assembly and remove (substitute) it for the assembly 

components. It will also create a model state to save this 

state. You will then be able to switch between the fully 

loaded assembly, and the Substitute version of the 

assembly. This is helpful when you need to insert the 

current assembly into another assembly multiple times. 

Instead of having an assembly containing hundreds or 

thousands of components, you can reduce the component count to a handful of 

substitutes. 

 

‘Revit Model’ will export a Revit model of our assembly.  

 

7. Next, look at the Output > Structure section of the 

simplify panel. This option allows us to set the ‘BOM 

structure’ of our model when it arrives in Revit. We will 

choose ‘Each top-level component’. 

 

‘All in one Element’. The Revit user will only be able to 

schedule the model as one item 

 

‘Each top-level component’. The Revit user will be able 

to schedule each top-level component as a separate item. 

 

8. Note, that you can set the file location and name here. We will use the defaults for this 

exercise. 

9. Note the check box, ‘Enable updating’. This option will allow us to update our Revit 

model using the same simplification settings, with a simple Right Mouse Buton click. We 

will make sure that this option is checked. 
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10.  Next, let’s look at the ‘Input’ section. Note that you 

can choose a Model state, View, or positional rep here. 
Make sure that ‘View’ is set to ‘Revit export’. 
 
 
 
 
 
 

 
11. Presets. At the very top of the Simplify Panel, you’ll 

find the ‘Preset’ drop down. 
 
The simplify tool has three built in presets that we can 
use to demonstrate the functionality of the simplify tool. 
Try them out. 
 
Presets allow us to save our settings to use repeatedly. 
We can even share our presets to help us standardize 
settings with our colleagues. 
 
Click this link to learn how to work with presets. 
 

The preset drop down will be set to ‘No simplification’ or ‘Last Used’, depending on 
your preferences. 
 
‘Remove the least detail (Small Parts and features)’ 
Observe the ‘Exclude components’ section – Parts that are smaller than a cube which 
measures 200mm on the diagonal have been excluded. 
 
Observe the ‘Remove features’ section. Holes with a diameter less than 50mm will be 
removed from each individual component, along with Fillets, Chamfers and more. You 
can see what will be removed by clicking on the ‘Highlight’ button. 
 
Tip: Use the ‘preserve’ tool to keep features that are required for coordination that would 
otherwise be removed. 
 
‘Remove moderate detail (Medium sized parts and all listed features)’ 
Parts that are smaller than a cube measured 300mm diagonally will be removed. All 
features will be removed. 
 
‘Remove the most detail (Replace all parts with envelopes)’ 
Parts that are smaller than a cube measured 400mm diagonally will be removed. All 
parts will be replaced by a rectangular bounding box (envelope). 

  

https://knowledge.autodesk.com/support/inventor/learn-explore/caas/CloudHelp/cloudhelp/2022/ENU/Inventor-Help/files/GUID-0FDF0162-5374-4FC8-B6E3-59FDBC9AAA40-htm.html
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12. Look for the ‘replace with envelopes’ section of the simplify command. Notice that you 
can automatically replace the whole assembly or each top-level component, or individual 
parts with bounding boxes. 
 
Tip: ‘Replace with envelopes’ and ‘Output > Structure’ are independent. You could 
create a Revit model which is one bounding box, that could still be scheduled as top-level 
components. 
 

Take your time to experiment with the various simplification options. When you are done – 
click ‘Cancel’. We will look at ‘Bottom up’ simplification before we export our model to Revit. 
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Figure 9 Simplify Least - Features that will be removed are highlighted. 

 
Figure 10 Simplify Moderate - Features that will be removed are highlighted. 

 
Figure 11 Simplify Most  
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Simplify the Inventor Model (Bottom up) 

The simplify tool is a great time saver when simplifying an entire assembly. 

What if we want to use simplified subcomponents from a library? What if we want to re-use 

simplified components for FEA or CAM simulation? 

Autodesk Inventor 2022 includes a new workflow which will help us do this – it’s called ‘Model 

states’. 

‘Model states’ replace ‘Level of detail representations’ (LODs) that you might have used in 

previous versions of Inventor. Model states are different to LOD’s because they allow the 

suppression of features at the part level. 

Let’s look at an example. In the model browser, look for, and then open the component called 

‘Noiseless cart’. 

Production B (Sub-assembly) > material handling (folder) > Noiseless Cart_1219x813x965 

With the noiseless cart model open, go to the model browser and expand the ‘Model states’ 

folder. 

This component has two model states, ‘Master’ (The default model state) and ‘Medium’. 

RMB click over the ‘Medium’ model state and choose ‘Activate’. 

You’ll see a simplified version of the Noiseless cart – notice the features that have been 

suppressed or unsuppressed in the model browser. 

Component simplification using model states requires more thought, and more work on each 

individual model. However, this ‘bottom up’ method allows you to apply simplification to assets 

that can be saved into your library.  

Close the ‘Noiseless cart’ file without saving. 

 

 

  



 

45 | P a g e  

 

Creating a simplified model state 

How can we trigger a change in model state to all components in our model at the same time? 

Let me show you! 

In this Exercise we will: 

• Continue working with the dataset we have open 

• Create a new assembly model state 

• Link our assembly model state to our component model states. 

Open the data set for this exercise 

If you still have the file open from the previous exercise – continue on. 

If you like, you can open this version of the Inventor assembly, that already has the Revit model 

inserted for you. 

1. From the Inventor home page, navigate to: 

Get started (Tab) > Launch (panel) > Open (Button) 

2. Navigate to: 

3. C:\Datasets\IM500008\ 02 Insert and Simplify\ 

4. LMB select ‘Insert_and_simplify_END.iam’ 

(Inventor assembly file) and click on the ‘Open’ 

button. 

5. In the browser, expand the ‘Model states’ node. 

6. Hover your cursor over the ‘Model states’ node 

(folder) and right mouse button click. Choose ‘New’ 

from the context menu. 

 
 
 
 

 
Tip: If you see the ‘Click toggle edit scope’ warning, don’t worry, you can press ‘OK’ – or press 
‘Prompts>>’ to turn this warning off. 
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7. A new model state will be created called ‘Model state1’, rename this model state to 
‘Medium’ 
 

Tip: To rename the Model state, select the text (the name of the Model state) once with a 

left mouse button click, then pause, then left mouse button click again to make the text 

editable. 

8. Link the assembly model state to the part model states. 

Navigate to: 

Assemble (Tab) > Productivity (Panel) > Productivity tools 

(Button) 

 

Note: The ‘productivity tools’ button may show whichever 

tool you had active last. Click on the bottom half of the button 

to reveal the choices 

 

9. Select ‘Link Model states’ 

 

10.  In the ‘Link Model states’ dialog, left mouse button click ‘Medium’, and then click the 

‘OK’ button. 

Tip: If you see a ‘Selected model states change warning dialog, click ‘OK’ or click ‘Prompts >>’ 

to avoid this warning showing up in the future. 
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Changing the assembly model state to ‘medium’ will now trigger a change in all components that 

also contain a model state called ‘Medium’ 

Activate the master model state, then the ‘Medium’ model state to see the differences. 
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Exercise 03 - Export to RVT 

To recap. We have Referenced a Revit model into Inventor. We then placed our Inventor model 

into the same file using the same coordinate system. 

Oh No! We found a clash! 

We could create a screen shot of the clash to illustrate the problem. We could create a drawing 

showing the clash. But we aren’t going to do either of those things, we are going to export a 

Revit model from Inventor that we can send to the building design team for coordination. 

So far, we have simplified the Inventor model to remove detail that isn’t required for the purpose 

of 3D coordination. Now we will export the Inventor model to Revit. 

In this Exercise we will: 

• Open the data set for this exercise In Inventor 

• Export the Inventor model as a Revit project file (RVT). 

Open the data set for this exercise 

If you still have the Inventor file open from the previous exercise – continue on. 

If you like, you can open the version of the Inventor assembly that already has the Inventor 

model inserted and linked to the Revit model. 

1. From the Inventor home page, navigate to: 

Get started (Tab) > Launch (panel) > Open (Button) 

2. Navigate to: 

3. C:\Datasets\IM500008\03 Update Revit Model\ 

4. LMB select ‘Export to Revit’ (Inventor assembly file) and click on the ‘Open’ button. 

Export to Revit 

Previously – we saw how we can export to Revit using 

the options in the Simplify tool.  

This time, we will try another method.  

5. Navigate to: 

File (Menu) > Export (Section) > RVT (Option) 

6. Does this look familiar? You got it! This option also 

opens the simplify palette! 

 

Note: Look at the ‘Output > Type’ option. The Type 

is already set to ‘Revit Model (RVT’), and the option 

is greyed out – we don’t need to change the output 

type using this method – we already told Inventor 

what we wanted to do. 
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7. Set the pre-set to ‘No simplification’ 

8. Set the model state to ‘Medium’ 

9. Set the View to ‘Revit export’ 

10. Set the output structure to ‘Each top-level component’ 

11. Take a note of the file name and save location. 

12. Make sure that ‘Enable updating’ is checked. 

13. Click on the ‘OK’ button to complete the command. 

14. Be patient. 
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When the export is complete, look at the model browser. You will 

see a new folder ‘Revit exports’. You’ll see every Revit export 

you create here. 

 

Hover your cursor over an export node. Right mouse button click. 

You’ll see options to ‘Edit Simplify’ (Change the simplify settings 

and export again) or ‘Update’ (Update the export using the same 

simplify settings. 

 

Note: The exported Revit file should not be re-named or moved in 

order for the update function to work. 

If Inventor cannot ‘find’ your exported Revit file, it will recreate the 

folder path and generate a new RVT file as if it was exporting for the first time. 

 

Close this file when you are finished. You can save and re-use it in exercise 5, or you can close 

it without saving and use the file I’ve prepared for you.  

Extra Credit 

Imagine that you need to simplify your model to share it with multiple stakeholders on your 

project. 

Each stakeholder requires a different level of detail. How would you create multiple RVT 

exports? 
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Exercise 04 – Link the RVT export into a Revit model 

As a factory production line or equipment provider, your role may now be complete. You’ve 

provided an RVT file for coordination – now you’ll wait for feedback. 

In this exercise we’ll lift the curtain and find out what the Revit user will see when they import our 

model. 

We will learn how to link an RVT file into Revit. The advantage to linking a file into Revit, is that it 

will automatically be inserted with matching 0,0,0 coordinates. Our production equipment model 

will appear in exactly the right location to match the Revit project file. 

On a real BIM project, the BIM coordinator, Architect or General contractor can use this 

technique to coordinate your geometry with the design model. It’s a huge improvement on 

sharing ‘flat’ 2D drawings! 

 

In this Exercise we will: 

• Open the data set for this exercise In Revit 

• Navigate to the pre-prepared view 

• ‘Link’ the exported RVT that we created with Inventor, into the Revit model 
 

Open the data set for this exercise 

1. From the Revit home page, look for ‘MODELS’ and click ‘Open’ 

2. Navigate to: 

C:\Datasets\IM500008\ 04 Link into Revit\ 

3. LMB select ‘Link into Revit.rvt (Revit Project File) and click on the ‘Open’ button. 
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Link our RVT file into Revit 

To link a RVT (Revit Project) file into the current Revit Project 

1. In Revit, navigate to: 

Insert (Tab) > Link (Panel) > Link Revit (Button) 

2. Click on ‘Link Revit’ 

 

3. In the ‘Import/Link RVT’ dialog – browse to: 

C:\Datasets\IM500008\04 Link into Revit 

4. LMB select ‘Production B iam.rvt’ (Revit Project File) and then click on the ‘Open’ 

button. 

5. The RVT file will be loaded into the Revit project and will appear in the correct location on 

the screen. 

6. In the Project Browser, find the node called ‘Revit Links’ and expand it. You should see a 

‘Production B iam.rvt’ node here. 

7. Close this file when you are finished. You can save and re-use it in exercise 5, or you 

can close it without saving and use the file I’ve prepared for you.   

Figure 12 The completed workflow. The Inventor model is linked into Revit for coordination 
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Tip: To manage your linked files, navigate to: 

Insert (Tab) > Link (Panel) > Manage Links (Button) 

 

Extra Credit 

Name four ways that you could share your exported RVT file with your colleagues. 

Which one will be the best for you? 

Will this change from project to project? 
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Exercise 05 – Update the Inventor model, Exported RVT, and Linked model in 

Revit 

In the final exercise of this class, let’s assume that we’ve been asked to move the jib crane to fix 

the clash between the jib crane and the ducting. 

We’ll see how to do this, then we’ll update the coordinated dataset set with the new design. 

In real life, the sharing of files in this step would be manged inside Autodesk Vault (if you are all 

working for the same company) or in BIM 360 docs (part of Autodesk Construction cloud) if you 

are managing data for a BIM project. Or, (realistically) it might involve email, online file storage, 

or even an FTP site (yikes!). 

Before you start this exercise, please make sure that you’ve closed the datasets we 

previously had open in Inventor and Revit. 

In this Exercise we will: 

• Open the dataset for this exercise in Revit 

• Open the data set for this exercise In Inventor 

• Move the Jib Crane 

• Update the Revit export 

• See the updated file in Revit 
 

Open the data set for this exercise In Revit 

Let’s start by opening the Revit dataset. 

1. Navigate to: 

C:\Datasets\IM500008\ 05 Update the design\ 

2. LMB select ‘AS-AK-00-ZZ-M3-A-00001_Update the design.rvt (Revit Project File) and 

click on the ‘Open’ button. 

3. Notice the clash between the jib crane and the ducting that we saw earlier. 

Open the data set for this exercise In Inventor 

Now we can open the Inventor dataset. We will have both the Revit and Inventor datasets open 

at the same time. 

4. From the Inventor home page, navigate to: 

Get started (Tab) > Launch (panel) > Open (Button) 

5. Navigate to: 

6. C:\Datasets\IM500008\ 05 Update the design\ 

7. LMB select ‘Update the design.iam’ (Inventor assembly file) and click on the ‘Open’ 

button. 
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Move the Jib crane 

To move the jib crane, we’ll need to edit the inventor sub-assembly that contains the jib crane. 

This is ‘Production B’.  

8. In the assembly browser, find the node that represents the sub-assembly ‘Production 

B:1’ 

9. Hover your cursor over ‘Production B:1’, right mouse button click and choose ‘Edit’ 

from the context menu. 

10. In the assembly browser, find and expand the node ‘Slewing Arm Jib 

Crane_4267x610x3658:47’ 

11. Under the jib crane node, find the constraint called ‘Jib Crane Offset’ 

12. Hover your cursor over this node and Right Mouse button click, select ‘Edit’ from the 

context menu. 

13. In the ‘Edit constraint’ dialog, set the Offset to ‘-1000mm’ (Minus one meter). 

14. Click ‘OK’ to close the ‘Edit constraint’ Dialog. The job crane will move position. 

15. Navigate to: 

Assemble (Tab) > Return (Panel) > Return (Button) – click ‘Return’ (the top half of the 

button) 

This will return you to the top-level assembly. 

Update the export from Inventor. 

Now we can update the RVT model that we exported out of Inventor. 

16. In the assembly browser, find the ‘Revit Exports’ folder, and expand it. 

17. Find the node called ‘Production B_Update the design.rvt’ 

18. Hover your cursor over this node and right mouse button click. Choose ‘Update’ from the 

context menu. 

19. Be patient while Inventor updates the exported Revit model… 

Update the linked project file in Revit. 

Now we can see how the exported Inventor file looks inside Revit. 

20. From the Revit home page, look for ‘MODELS’ and click ‘Open’ 

21. Navigate to: 

22. C:\Datasets\IM500008\ 05 Update the design\ 

23. LMB select ‘AS-AK-00-ZZ-M3-A-00001_Update the design.rvt (Revit Project file) and 

click on the ‘Open’ button 

24. In the Revit project browser, navigate to the ‘Revit links’ node, and expand it. 
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25. Hover your cursor over ‘the node called ‘Production B_Update the design.rvt’, and right 

mouse button click. 

26. From the context meu, choose ‘Reload’. 

27. Keep an eye on the linked model – you should see it update as the linked model is 

reloaded. 

Conclusion 

Buildings. and the items they contain are becoming more closely linked through the process of 

digitisation. 

Nowhere is this closer than in the production facility. An integrated Factory model, coordinating 

the production line and the building, is a step on the way to digitising your facility and opens you 

to the benefits of a digital twin. 

Buildings are built from components that are made by manufacturers. There is no escaping the 

role of manufacturers in the construction industry, from the processing and manufacturing of 

building materials to building products and equipment and specialist construction systems, one 

industry could not exist without the other. 

The construction industry has a poor reputation for efficiency and productivity, and it is looking to 

manufacturing for guidance on optimising and automating how we make buildings. 

The worlds of manufacturing and construction are rapidly converging; it’s more important than 

ever that the tools we use to design and make our products help us to collaborate effectively. 

In this presentation, we saw a workflow which helps to coordinate manufacturing and BIM by 

referencing a Revit model into inventor to use as a design refence, then round-tripping the 

Inventor model back into Revit for coordination and review. 

This process could easily be managed in Autodesk Vault (for on-premise data management) or 

Autodesk Construction cloud/BIM 360 Docs for project based BIM management. 

I hope that you found this class useful, and that you have the confidence to try out this workflow 

for yourself. Please send me your feedback on this class to Paul.Munford@Autodesk.com. 

What next? 

Use it or lose it! Make sure that you practice this workflow to ensure that you remember how it’s 

done. Test it with your own dataset. 

Please feel free to share this class with your colleagues, or use the dataset, handout and video 

to conduct training in your company. 

If you’d like to have your say on what we can do to improve this workflow, please leave a 

message on the forum, a suggestion on the ideas board, or join the feedback community to test 

new functionality which may be included in future versions of Revit and Inventor. 

Check out the ‘Resources’ section of this handout for details. 

https://www.autodesk.com/autodesk-university/class/Autodesk-Tandem-Delivering-Value-BIM-Owners-Digital-Twin-2020
mailto:Paul.Munford@Autodesk.com
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Thanks 

Thank you very much to my Jon Bagley, Bill Bogan and Jerry Burns who helped me by 

reviewing this class – any remaining mistakes are my own! 
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Resources 

Find more free classes on Autodesk Inventor’s BIM workflows from previous AU’s on Autodesk 

University online: 

Revit and Inventor classes at Autodesk University On-line 

If you want to learn how to make Revit families (.rfa) with Autodesk Inventor, make sure that you 

also watch: 

‘Anybody Can Do IT: Easily Build Revit Content in Inventor’ by Pete Strycharske 

I can recommend this class for a broad overview of the topic: 

‘Providing Manufacturer-Specific BIM Content for Revit from Inventor’ 

And this class for insight into the differences between Inventor and Revit and the customers they 

serve: 

‘Do You REALLY Want Manufacturer’s Content? Success Stories in Repurposing Manufacturing 

for BIM’ 

I recommend this class for more information on the ‘AnyCAD for Revit workflow introduced in 

Inventor 2021. 

Revit to Inventor: BIM Exchange for Custom Fabrication Hands-On Lab 

This class is a great introduction to Digital Twin: 

Autodesk Tandem: Delivering the Value of BIM to Owners with a Digital Twin 

Your feedback for Autodesk 

This is my favourite class at AU. Ask the inventor developers anything you like and get an 

honest answer! 

510306 Ask me anything: Deep dive with the Inventor developers 

You can ask questions and look for answers all year round in the Autodesk Inventor Community 

Forums 

Suggest your ideas, or vote on the ideas of others – how can we improve Inventor? 

Autodesk Inventor 'Ideas' 

Join the Autodesk feedback community. Try out prototypes of new functionality for future 

releases and have your say on the future of Autodesk products: 

https://feedback.autodesk.com/ 

Find Inventor on social media: 

YouTube Twitter  Linkedin Facebook Instagram 

https://www.autodesk.com/autodesk-university/au-online?query=bim&facet_product%5B0%5D=urn%3Aadsk.content%3Acontent%3A4594dd66-7b8c-45dd-9bb2-1df1b909e871
https://www.autodesk.com/autodesk-university/article/Easily-Build-Revit-Content-Inventor-2021
https://www.autodesk.com/autodesk-university/class/Providing-Manufacturer-Specific-BIM-Content-Revit-Inventor-2016
https://www.autodesk.com/autodesk-university/class/Do-You-REALLY-Want-Manufacturers-Content-Success-Stories-Repurposing-Manufacturing-BIM-2017
https://www.autodesk.com/autodesk-university/class/Do-You-REALLY-Want-Manufacturers-Content-Success-Stories-Repurposing-Manufacturing-BIM-2017
https://www.autodesk.com/autodesk-university/class/Revit-Inventor-BIM-Exchange-Custom-Fabrication-Hands-Lab-2020
https://www.autodesk.com/autodesk-university/class/Autodesk-Tandem-Delivering-Value-BIM-Owners-Digital-Twin-2020
https://forums.autodesk.com/t5/inventor-forum/bd-p/78
https://forums.autodesk.com/t5/inventor-forum/bd-p/78
https://forums.autodesk.com/t5/inventor-ideas/idb-p/v1232
https://feedback.autodesk.com/
https://www.youtube.com/user/AutodeskMFG/featured
https://twitter.com/Adsk_Inventor
https://www.linkedin.com/groups/130938/
https://www.facebook.com/adskinventor/
https://www.instagram.com/adskinventor/

